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GIS Career Awareness Learning Module # 1  
Version 4.0 July 28, 2008  

 

The Digital Earth --- Virtual Globes and Computerized Maps  
 

• Estimated Time:  2.5 hours 
• Learning Goal:  This module will introduce the concept of the Digital Earth.  

The intended goal of all of the module’s learning activities is to demonstrate to 
students how useful it would be to spatially represent data and imagery on virtual 
globes and computerized maps (computer/digital cartography).  In the course of 
the learning activities, students will have the opportunity to learn and use 
engaging software such as Google Earth. 

• Platforms:  PC, Mac, or UNIX.  
• Software Tools Required:  Google Earth, Web browser with high-speed Internet 

Access.  Installation instructors for educators and users are available in the 
Appendix at the end of this learning module. 

• INSTALLATION: Educators or Lab Administrators may view step-by-step 
installation instructions in the Appendix of this learning module. 

• Allied to California Content standards nine through twelve: GIS Learning 
module #1 can be allied to the following California Content standards: 
• History-Social Science Content Standards 

11.2.2 Describe the changing landscape, including the growth of cities 
linked by industry and trade, and the development of cities divided 
according to race, ethnicity, and class.  

• Science Content Standards 
6.b (Ecology) Students know how to analyze changes in an ecosystem 
resulting from changes in climate, human activity, introduction of nonnative 
species, or changes in population size.  

• English-Language Arts Content Standards 
1.1 (Writing) Establish a controlling impression or coherent thesis that 
conveys a clear and distinctive perspective on the subject and maintain a 
consistent tone and focus throughout the piece of writing.  

 
 
 

 
Note: This Web-based GIS learning module was developed with support from a  National Science 
Foundation – Advanced Technological Education Program Research Grant (NSF-ATE DUE # 0401990): 
“A Scalable Skills Certification Program in Geographic Information Systems (GIS).” 
( http://geoinfo.sdsu.edu/hightech ) 
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ANSWER ALL QUESTIONS ON THE SEPARATE ANSWER SHEET 
 

Section 1 – Google Earth 
 

Part I – Google Earth and its Basic User Controls 
 
Google Earth is a friendly 3D, Internet-based Geographic Information System (GIS) 
application. This application was originally developed by the Keyhole Inc. located in 
Silicon Valley. In 2004, Keyhole Inc. was acquired by Google. Google re-packaged 
Keyhole’s 3D Virtual globe software and release the new version, call “Google Earth” in 
June, 2005. The concept of the Digital Earth was unveiled to the general public by 
Google Earth; many researchers or governments agencies started to utilize Google Earth 
for their works. The software enables you to virtually fly over any place in the world 
from your computer. 
 
The following exercises will give you hands on experience with using these software 
applications as learning and research tools. 
 
Begin by starting the Google Earth application.   

Start Google Earth, you have two ways:  

• Click on the Google Earth icon  on your desktop. 
• Use the “Start” button (Start > All Programs > Google Earth > Google Earth).   

 
Learn about Google Earth’s basic features and controls. Please spend no more than 10 
minutes completing the following steps. 
 

[1] Toggle on some Points of Interest such as “Roads,” “Terrain,” and “Borders” by 
clicking on the check boxes next to them (Scroll through and expand the folders in the 
Layers list of the bottom-left side of Figure 1-1 below).  This will enable you to view 
these features on the virtual globe when you are zoomed in sufficiently close.  

 
Figure 1-1: Google Earth Primary Map Controls and Functions 
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Go to the “View” pull-down menu and toggle on the “Overview Map” by clicking on the 
option from the pop-down list.  If it is already selected, leave it alone. 

 
[2] Here is a list of some of the basic controls and their functions: 

a) The “Look Joystick” control   : Use the Look joystick to look around as 
if you were turning your head. Click an arrow to look in that direction or continue 
to press down on the mouse button to change your view. After clicking an arrow, 
move the mouse around on the joystick to change the direction of motion.  

b) The “Move Joystick” control : Use the Move joystick to move your position 
from one place to another. Click an arrow to look in that direction or continue to 
press down on the mouse button to change your view. After clicking an arrow, 
move the mouse around on the joystick to change the direction of motion.  

c) The Zoom Slider : To get closer to the ground to see more detail but in a smaller 
geographic area. Try to clicking and dragging the slider toward the plus/minus sign; 
try double-clicking on any part of the image. 

 

d) The Hider/Show Sidebar   : To conceal or the display the side bar (Search, 
Places and Layers panels).  

e) The “Add Placemark” control   : To add a placemark for a location. 
 

f) The “Measure” control   : To measure a distance or area size. 
 

g) The “Add Overlay” controls   : To create and add your own 
overlay features onto Google Earth.  You can draw a polygon, a line, or add a 
graphic image to the map which Google Earth will “drape” over the terrain.   
 

h) Email   : To send the current view to a user with Google Earth or send an 
image of the current view to an email recipient.  

 

i) : To show the current view in Google Maps in your web browser. 

j) :  A switch press between sky and earth. Click it to view stars, constellations, 
galaxies, planets and the Earth's moon. 

Let’s quickly try some of the steps you learned above. Spend about four minutes. 
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[1] Be sure that Google Earth is running. 
 
[2] Type “San Diego” in the “Fly To” address field and then press the enter key.   
 

[3] Now we are going to introduce an important concept in GIS called, “Map layers.” 
Map layers are layers of map features, data, or imagery that can be overlaid or 
stacked together like layers on a cake or toppings on a burger.   
 
Now turn on the “Geographic Web,” “Terrain,” “Roads,” and “3D Buildings” features 
in the “List of Layers” (Figure 1-2); answer the following questions A-1 and A-2 on 
the separate answer sheet: 

 

 
 

Figure 1-2: List of Layers 
 

A-1: Click the points (blue, purple, and orange) shown on the map, what 
websites provide these information? 
 
Try some examples of 3D View. 

 
a)  The Grand Canyon in Arizona (dramatic terrain): 

 
• Fly to the Grand Canyon by Entering “Grand Canyon” in the “Fly To” Address 

Field, choose terrain, and press enter. (See Figure 1-3)  
 

• Click on the “Look Joystick” control until you see the terrain (See Figure 1-4).  
 

• Exploring the local area by moving around (panning) and zooming in and out. 

List of Layers 
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Figure 1-3 the Grand Canyon                        Figure 1-4 a 3D perspective of  

in Arizona                                          Grand Canyon in Arizona 
 

b) Downtown San Diego:  
 

• Try the same way as above. Choose Roads, 3D buildings, borders, and free to 
zoom in, zoom out and tilt (Figure 1-5). 
 

You just need to enter “San Diego, CA” in the “Fly to” Address Field. The 
focus of Google Earth is the downtown San Diego area. 

 

 
 

Figure 1-5 Downtown San Diego 
 

A-2: After touring the Grand Canyon and downtown San Diego, write 
down your opinions regarding the usefulness of different function like 
“terrain” and “3D Buildings”.  

Fly to Address Field
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[4] Now add more feature layers to Google Earth.  You may want to select “Borders,” 
“Transportation,” “Geographic Features,” etc., and their associated features may not 
be visible until you sufficiently Zoom In or go to the geographic areas where they 
occur.  This is called “scale-dependent features.”    
 
[5] Now you are free to use the Google Earth navigation tools like “Zoom In,” “Zoom 
Out,” “Tilt,” etc. to explore the entire globe.  

 
 
 
 
Part II – Please complete the following exercises and answer the following questions.  
You should try to spend no more than 30 minutes doing these exercises: 
 
To locate a unique point on the earth, a coordinate system must be used.  Google Earth 
and many other applications use the geographic coordinate system of latitude and 
longitude. 
 

[1] Latitude: Latitude describes an imaginary survey line which runs east to west. 
You can think of these parallels of latitude as forming the rungs on an imaginary 
ladder.  Latitude, when used in a coordinate, is expressed as an angle from 0 to 90 
Degrees either north or south of the equator (See Figure 1-6).   

 
The most important parallel of latitude is the equator.  It surrounds the middle of the 
earth like a belt and can be described as 0 Degrees latitude.   

 

 
 

Figure 1-6: Latitude 
 

In the “Decimal Degrees” system, it is important to note that when you are going north 
of the equator the values range from 0 to 90 Degrees and you are going in the 
“positive” direction.  Think of this as going “up” on the imaginary ladder starting from 
the equator.  You go south of the equator; the values range from 0 to -90 Degrees.  
Think of this as going “down” the imaginary ladder from the equator.  
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As an example, Sydney, Australia, which is in the Southern Hemisphere, lies at 
approximately -33.87 Degrees Latitude (note the negative sign). 
Anchorage, Alaska which lies in the Northern Hemisphere lies at approximately 61.22 
Degrees Latitude (note that it’s a positive value). 
 
When used on a map, a single latitude value is sort of like the equivalent of a y-
coordinate in the Cartesian coordinate system. 

  
[2] Longitude: Longitude describes an imaginary survey line running south to north.  
There are 360 Degrees of longitude and they all converge at the North and South Poles. 
Longitude, when used in a coordinate, is expressed as an angle from 0 to 180 Degrees 
either west or east of the Prime Meridian (See Figure 1-7).   
 
The most important meridian of longitude is the Prime Meridian.  This imaginary line 
extends from the South Pole to the North Pole and passes through Greenwich, England.  
It can be described as 0 Degrees longitude. 

 

 
 

Figure 1-7: Longitude 
 

In the “Decimal Degrees” system, it is important to note that when you are going west 
of the Prime Meridian, the values range from 0 to -180 Degrees and you are going in 
the “negative” direction. You go east of the Prime Meridian; the values range from 0 
to 180 Degrees. At positive OR negative 180 Degrees longitude, you reach the 
International Date Line.  This imaginary line runs from the South Pole to the North 
Pole in the middle of the Pacific Ocean and is on the opposite side of the earth from 
the Prime Meridian.   

 
As an example, Sydney, Australia, which is in the Eastern Hemisphere, lies at 
approximately 151.21 Degrees Longitude (note that it’s a positive value). 
Anchorage, Alaska, which is in the Western Hemisphere, lies at approximately   -
149.89 Degrees Longitude (note the negative sign). 
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When used on a map, a single longitude value is sort of like the equivalent of an x-
coordinate in the Cartesian coordinate system. 

 
[3] Decimal Degrees: Latitude and longitude are most commonly expressed in 
“Degrees, Minutes, and Seconds” or “Decimal Degrees.”  Both are equivalent.  
However, for the sake of simplicity, you are going to use “Decimal Degrees.” 
In order to view map coordinates in decimal degrees, you will have to make a change.  
First, select the “Tools” pull-down menu and click on “Options…” 
 
The Google Earth Options menu should appear (Figure 1-8).  In the Google Earth 
Options menu, be sure the “3D View” tab is selected and change the “Show Lat/Lon” 
option to “Degrees” (Figure 1-8).  In this case, the latitude (y-coordinate) and 
longitude (x-coordinate) will be represented in decimal degrees.  This is how most 
GIS and related software applications represent latitude and longitude.  Save the 
settings by clicking on the “OK” button. 

 

 
Figure 1-8: Google Earth Options Menu with Degrees Selected for Latitude and 

Longitude in the 3D View Tab 
 

Now you are going to determine what the Latitude and Longitude coordinates of your 
school are?   
 

Hint:  
a) Be sure the “borders” and “roads” features are selected in the List of Layers. 
b) Locate your school. 
c) Find out the latitude and longitude coordinate values by moving your mouse    

cursor over the center of your school in the view window. 
Coordinates will appear in the bottom-left corner (See Figure 1-9 below).   
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Figure 1-9: Latitude & Longitude Coordinates of Mission Bay High School 

 (San Diego, CA) 
 

Alternatively, you can enter the full address of your school in the “Fly To” address field. 
 

[4] After you determine where your school is located, create a Placemark that marks it.  
To do this you need to follow a few easy steps and spend no more than 8 minutes: 
 

• Make sure your school is displayed near the center of your screen. 
• Click the “Add Placemark” control.  It looks like a pushpin and is located near 

the top of your Google Earth window. 
 

A New Placemark control panel should pop-up and a Placemark will appear near the 
center of the screen (Indicated by the black arrow in Figure 1-10 below). 

 

 
 Figure 1-10: Creating a Placemark in Google Earth  

(Mission Bay High School, San Diego, CA) 
• Click and drag the Placemark on the map to the center of you school campus. 
 

Latitude & Longitude Displayed at the Bottom 
Left-side Comer of Scene 

Name Field 

New Placemark 
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• Type in the name of your school in the Name field of the New Placemark 
control panel (Figure 1-10).The Placemark will then, automatically display 
your school’s name.   

 
Before you press the OK button to finish creating the Placemark, fill in the following 
information from the New Placemark control panel on the separate answer sheet: 

 
A-3: Name Which You Entered for the School: 

 
• Click on the “View” tab in the New Placemark control panel.  You will see the 

Latitude and Longitude that is associated with your Placemark. 
 

Based on the information that you read from the New Placemark menu, fill in the 
following on the separate answer sheet: 

 
A-4: Latitude as Shown in the New Placemark control panel: 
 
A-5: Longitude as Shown in the New Placemark control panel: 

 
• Click on the OK button to save the new Placemark of your school on the map. 

When you Zoom Out, the new Placemark of your school will remain visible. 
 

Now you will determine what is the direct straight line distance between your school 
and San Diego State University (SDSU)?   
 

• Type the address of SDSU in the “Fly To” address field.  The address is near 
5398 Campanile Dr., San Diego, CA. 

 
• Create a new Placemark for SDSU.   

 
• Zoom out enough so you can see both Placemarkers (your school and SDSU).  

You should be able to do this even if your school is located in another country! 
 

• Open the Measure Tool control, which is located in the Tools pull-down menu.  
It might also be called Ruler depending on which version of Google Earth you 
are using.  Use Miles as your measuring unit and click on your school and then 
click on SDSU while the Measure Tool is open.  (Figure 1-11) 
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Figure 1-11: Determining the Distance between Two Places 
 

     Answer the following question on the separate answer sheet: 
 

A-6: Distance between Your School and SDSU (miles):  
 

Now close the Measure Tool by clicking on the X on the top right-hand corner of the 
Measure Tool menu. 
 
In this next step, you will create street map directions between your school and SDSU.   
 

• The “From”: Click right mouse (or Mac users, hold down the Control button 
and mouse Click) on your newly-created high school Placemark.  A pop-up 
menu should appear. Select the “Direction from here” option. 
 

• The “To”: Right mouse click (or Mac users, hold down the Control button and 
mouse click) on the SDSU Placemark which you created.  Select the “Direction 
to here” option. 

 
 Now, Google Earth should automatically create the street navigation direction 
between your school and SDSU (Figure 1-12)! 

 
 

Distance 
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Figure 1-12: Generating Turn-by-Turn Navigation Instructions 
 

If you zoom into your school, you will see street by street instructions all the way to 
SDSU! 

 
A-7: Copy down the first driving instruction that Google Earth lists 
FROM your school (Just copy down the first one!) on the separate answer 
sheet: 

 
Now, let’s try something really cool.   
 
• Press the “play” button under your list (Figure 1-12) and watch the route fly over 

animation.  (Some versions of Google Earth may not have this feature enabled.) 
 

[5] Other questions with Google Earth. 
 

a) “Area 51” is a Top Secret U.S. Military site in the Nevada desert that many in the 
government claim does NOT exist!  The coordinates are 37.249361,-115.812339.   
 
Now briefly answer the following question based on what you find.  What is Area 
51? (Hint: Copy these coordinates into the “Fly To” address field.  Be sure the 
“Fly To” address field tab is selected!) 

 
A-8: Briefly describe “Area 51” on the separate answer sheet: 

  
b) What is the name of the nearest Pizza restaurant to your school? (Hint: Make sure 

your school is near the center of the screen then; Select the “Find Businesses” tab 
located next to the “Fly To” tab (Figure 1-13) and enter Pizza in the “What” field 
then press enter.) 
 

 

Generated Turn-by-
turn Instructions 

Fly Over Route 



13 
 

 
 

Figure 1-13: A Local Search of Pizza Restaurants 
 

A-9:  What is the name of the nearest Pizza Restaurant to your school?  
(Answer on the separate answer sheet.): 

 
Measure how far it is from your school with the Measure Tool. 

 
A-10: How far is the Pizza Restaurant from your school? (Give the 
distance in feet.)  (Answer on the separate answer sheet.): 

 
c) Alcatraz Island, near San Francisco, California, used to be used as an 

“inescapable” high-security prison where the worst and most notorious criminals 
were kept.  The island known as “The Rock” is surrounded by dangerous currents 
and freezing-cold water.  It was supposed to be nearly impossible to escape! 
 
• Determine which direction the city of San Francisco is from Alcatraz Island 

and how far apart they are.  (Hint: Use the Fly To field and type Alcatraz.)   
 

• The idea is to determine how far someone needs to swim in the ice-cold water 
to escape the prison island (If you need to know the city names on the viewer, 
simply toggle on the layer called, “Populated Places” in the “List of Layers.”)   

 
• Determine what direction the Golden Gate Bridge is from Alcatraz Island. 
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Figure 1-14: Placemark of Alcatraz Island, San Francisco and the Golden Gate 
Bridge shown on Google Earth Map 

  
A-11: Which direction must you go (North, South, East, West) from 
Alcatraz Island to the shores of the city of San Francisco? (Answer on the 
separate answer sheet.): 
 
A-12: How far apart is Alcatraz Island from the nearest point along the 
shoreline of the city of San Francisco (in feet)? (Answer on the separate 
answer sheet.): 
 
A-13: Which direction (North, South, East, West) is the Golden Gate 
Bridge from Alcatraz Island? (Answer on the separate answer sheet. 
(Make sure the 3D Buildings layer is toggled on.) 
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Part III – Google Earth Applications 
 

[1] The Bird Flu Example. You should spend no more than 10 minutes to finish this 
part. 
 

Bird flu is a contagious viral infection that can affect all species of birds. The 
contagious virus lives primarily in the respiratory system in the infected birds, and 
human infection occurs when people come into contact with infected birds or 
contaminated surfaces.  There are thought to be millions of migratory ducks and 
wildfowl which carry the disease. Worldwide, according to the World Health 
Organization, more than 135 humans’ infections of the virus have been recorded. 
 

On November 16, 2005, Nature Magazine's Senior Reporter Declan Butler has 
thoroughly researched the Avian Flu outbreak information and has published the 
confirmed cases of Avian Flu in a Google Earth file. His avian outbreak map includes 
Human cases, and a time series of placemarks showing the progression of the flu over 
the last 18 months. 

 
a) Click the link http://www.nature.com/nature/googleearth/avianflu1.kml to open 

the KML file. Then Google Earth will be automatically launched (Figure 1-15). If 
you see alert message window, click “continue”.  
 

 
 

Figure 1-15: Bird Flu Outbreak map of Google Earth 
 

b) In the “Place Panel”, select the layer of “Additional datasets.”  If you see the alert 
message window such as “Unsupported image format, go_Russia.png”, click “ok” 
and remove the Russia layer (“Additional Datasets -> Gridded density of poultry 
worldwide->Russia”) 
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This way you can view the poultry density for any continent you are interested in. 
You can focus on the human cases or animal breaks by selecting the respective 
layers. 
 
For example, you may notice that there were quite a few human cases happened 
in the first several months of 2006 in the Middle East (Figure 1-16). For each case, 
you can make an inquiry to learn more information by directly clicking on the 
symbol. Please keep track of the spread of the flu virus based on the maps. 

 

 
 

Figure 1-16: Bird Flu Outbreak map of Google Earth Focused in the Middle East 
 

A-14: Describe the geographic and seasonal patterns of the bird flu for 
both bird and human cases in the Middle East by viewing the bird flu 
maps.  
  
A-15: Try to identify how many human cases happened in Turkey and 
report their Latitudes and Longitudes (Hint: in the place panel, only 
select the “Map of human cases”).  
  
A-16: According to the maps, what region could be the most popular 
areas that are impacted by the bird flu (Hint: Use poultry density map 
and if possible try to search for bird migration information)? 

 
 

[2] The Google 3D Warehouse Example. You should spend no more than 10 
minutes to finish this part. 
 
Computer-aided design (CAD) is the use of computer technology to aid in the design 
of 3D models and/or 2D drawings of physical components. CAD has become an 
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especially important technology within the scope of computer-aided technologies.  
Google has developed its own CAD software “Google Sketchup”. You can use it to 
create, modify and share 3D models. It's easier to learn than other 3D modeling 
programs, which is why so many people are already using it. 
 
The Google 3D Warehouse is an online repository of 3D models. Anyone can search 
for and download models, but to publish your own, you'll need to sign in using your 
Google account.  If you model 3D buildings and would like to share them with the 
world, you can do so through the "Best of the 3D Warehouse" layer in Google Earth. 
Only the very best models are selected for inclusion in this layer. 
 
a) Navigate to the website http://sketchup.google.com/3dwarehouse and click the 

link “Featured Google Earth Modelers” under the catalog of “3D Building 
Collection” (Figure 1-17). 
 

 
 

Figure 1-17: Google 3D Warehouse 
 

b) Choose any collection you interest in and click on it. 
 

A-17: Please write down the name of the collection you choose and the 
people who share this collection. How many models are included in this 
module? (Answer on the separate answer sheet.) 

 
c) Click on “View in Google Earth”  

 
d) Click any model you interested in and see the 3D module in Google Earth (Figure 

1-18). (Note: not all 3D models are available to see in Google Earth.) 
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Figure 1-18: an Example of 3D Buildings in Google Earth 
 

A-18: Please write down the name of the model you choose and describe 
this 3D model simply. (Answer on the separate answer sheet.): 
 
 
 
 
 
 

Section 2 – Written Assignment 
  
  
Now that you have seen and worked with examples of digital globes and 
computerized maps, we would like you to answer some questions about them.  We 
want you to combine all of your answers into a 250-word paragraph (approximately 
one typed page) by including the following information on the separate answer sheet: 
 
B-1: In your paragraph, quickly describe (in two sentences or less) the GIS 

applications that you used (Google Earth).   
 
B-2: In your paragraph, also answer if you think that the GIS applications 

(Google Earth) can help people? It what ways can they help people? 
In what kinds of occupations/industries would they be useful? 

 
B-3: In your paragraph, based on your experience with GIS applications 

(Google Earth), please discuss which application you liked the best 
and tell us WHY?   Please also discuss what the best or “coolest” 
feature of your favorite application was.  
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Student Survey 
  
  
This learning module was developed specifically for you---the students---in order to 
expose you to GIS and related geospatial technologies.   
 
GIS and related geospatial technologies, similar to what you worked with in this learning 
module, are major components of one of the most important new industries for career 
growth.  Businesses, organizations, and governments are increasingly seeking skilled 
talent in this industry.  
 
Now, to benefit other students and the authors of this learning module, you are required 
to finish this Student Survey and please send it back to the San Diego State University 
NSF-ATE team. We would greatly appreciate your input.  Please take time to answer 
these questions as openly and honestly as possible.  They will not affect your grade or 
score.  You can provide your feedback to your teacher/educator along with the learning 
module answers on the separate answer sheet. 
 
 
Thank you for helping us improves our modules! 
 
S-1: What did you like best about the learning module one?  Why? 
 
S-2: What did you like least about the learning module one?  Why? 
 
S-3: Was there anything that was really hard to understand or difficult to complete in 

the module one?  What was it?  Why? 
 
S-4: Is there anything in this learning module one that we can add, exclude, or change 

to make it better?  What is it?   
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
STUDENTS MAY STOP HERE! 

------------------------------------------------------------------------ 
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Appendix: Installation Instructions for Google Earth 
 
These simple instructions have been written using screen shots and instructions for the Windows 
Operating System.  Installation instructions for the Mac and Linux Operating Systems are similar. 
 
Be sure to have “administrative” privileges on the computer you are installing the software on.  
Accounts on computers in a lab setting usually limit installation to users with administrative 
privileges only. 

 
1. Open your Web browser and navigate to URL: 
http://earth.google.com/download-earth.html and click “agree and download” 
 
2. On the next Web page, click on the “Download Google Earth” button. 
 
After you have clicked on the “Download Google Earth” button, specify where you want to save 
the installation file on your computer and keep the original file name. 
 
 

 
 

Figure A: Part of What is Displayed on the Web Page after Pressing the “Download Google 
Earth” Button 

 
NOTE:  Web browsers with pop-up or download blocking may get an error message.  If this is 
the case, click on the “click here to start it” link displayed on the download page to manually 
initiate a download (Figure A). 
 
3. After saving the installation file to your computer, close your Web browser and run the 

installation file by clicking on it. 
 

4. Follow the Google Earth installation instructions that follow and accept the licensing 
agreement and any other installation messages that appear.  The default “Complete” 
installation is sufficient for the learning module. 

 
WINDOWS USERS NOTE: If you are given an option to “switch to ‘DirectX’mode,” we 
recommend that you respond by clicking “No” and  keep Google Earth in ‘OpenGL 
Software Emulation’ mode since it is compatible with a greater number of computer 
graphics cards. 

 

Answers to some of the most popular Google Earth-related installation questions are also 
available at http://earth.google.com/faq.html. 

  


